 Ch­¬ng 1:
 HÖ so¹n th¶o V¨n b¶n 

Bµi 1:: Khëi ®éng 

I.  Khëi ®éng vµ tho¸t khái word 2003:

[image: image1.png]
Th«ng th­êng trong m«i tr­êng windowsXP, c¸c øng dông th«ng dông cña Microsoft Office th­êng cã s½n biÓu t­îng trªn mµn h×nh lµm viÖc cña windows.  Trong tr­êng hîp nµy nÕu cÇn khëi ®éng ch­¬ng tr×nh so¹n th¶o WinWord ta bÊm ®óp chuét vµo biÓu t­îng:

(BiÓu t­îng trªn thanh c«ng cô cña Microsoft Office ta chØ cÇn bÊm 1 lÇn)


NÕu kh«ng cã biÓu t­îng cña Winword trªn mµn h×nh ta cã thÓ thùc hiÖn khëi ®éng ch­¬ng tr×nh theo c¸c b­íc sau:


(1) BÊm vµo nót Start


(2) Chän thanh Programs

(3) BÊm chän ch­¬ng tr×nh Microsoft Ofice (h×nh bªn). 

· Tho¸t khái ch­¬ng tr×nh: 3 c¸ch:

+ KÝch chuét tr¸i vµo dÊu X gãc trªn bªn ph¶i mµn h×nh. 

+ Ên tæ hîp phÝm Alt + F4. 

+ Vµo File chän Exit. 

II.  Mµn h×nh lµm viÖc :


Sau khi khái ®éng thµnh c«ng word2003 sÏ më ra mµn h×nh mét cöa sæ v¨n b¶n míi víi tªn Document1:
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Thanh menu lÖnh gåm:
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Bµi 2: c¸c thao t¸c c¬ b¶n

i.  c¸ch sö dông tiÕng viÖt:


Trong hÖ so¹n th¶o v¨n b¶n hiÖn nay ®ang sö dông c¸ch gâ tiÕng ViÖt phæ biÕn lµ kiÓu gâ TELEX cô thÓ nh­ sau:

C¸c nguyªn ©m


Phô ©m

 
DÊu
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VD: ®Ó ®¸nh Häc tËp tèt ta thùc hiÖn nh­ sau Hocj taapj toots
Chó ý: §Ó gâ ®­îc TiÕng ViÖt ta ph¶i khëi ®éng ch­¬ng tr×nh Vietkey 2000 (hoÆc ch­¬ng tr×nh Unikey). 
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C¸ch khëi ®éng: Start       Program         Vietkey 2000

ii.  C¸c thao t¸c c¬ b¶n:


1.  Di chuyÓn con trá so¹n th¶o:
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 - Di chuyÓn con trá so¹n th¶o vÒ bªn ph¶i 1 kÝ tù gâ phÝm 
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 - Di chuyÓn con trá so¹n th¶o vÒ bªn tr¸i 1 kÝ tù gâ phÝm 
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 - Di chuyÓn con trá so¹n th¶o xuèng 1 dßng gâ phÝm 

 - Di chuyÓn con trá so¹n th¶o lªn 1 dßng gâ phÝm 

 - Di chuyÓn con trá so¹n th¶o lªn 1 trang mµn h×nh gâ phÝm  PageUp

 - Di chuyÓn con trá so¹n th¶o xuèng 1 trang mµn h×nh gâ phÝm PageDown

 - Di chuyÓn con trá so¹n th¶o vÒ ®Çu dßng gâ phÝm Home

 - Di chuyÓn con trá so¹n th¶o vÒ cuèi dßng gâ phÝm End

 
* Ngoµi c¸c thao t¸c di chuyÓn con trá so¹n th¶o b»ng bµn phÝm ta cã thÓ sö dông chuét ®Ó ®Þnh vÞ con trá so¹n th¶o: di chuyÓn con trá chuét vÒ vi trÝ v¨n b¶ncÇn ®Þnh vÞ con trá so¹n th¶o vµ bÊm  lÇn vµo nót chuét tr¸i. 


2.  §¸nh v¨n b¶n:


- §¸nh c¸c ký tù: chÕ ®é ngÇm ®Þnh (®Ìn Caps Lock t¾t) mçi ký tù ®­îc gâ trªn bµn phÝm sÏ hiÖn mét ký tù th­êng t­¬ng øng trªn mµn h×nh t¹i vÞ trÝ con trá, muèn gâ ký tù in hoa ta gi÷ phÝm Shift vµ gâ ký tù ch÷ c¸i bªn bµn phÝm (Chó ý: khi ®Ìn Caps Lock bËt th× cã hiÖu øng ng­îc l¹i, muèn bËt hoÆc t¾t ®Ìn Caps Lock gâ phÝm Caps Lock). 
- Xuèng dßng v¨n b¶n: th«ng th­êng khi ch­a hÕt ®o¹n v¨n b¶n ng­êi dïng cø tiÕp tôc ®¸nh word sÏ tù ®éng xuèng dßng khi hÕt lÒ ph¶i trang v¨n b¶n.  NÕu muèn xuèng dßng theo ý muèn, ng­êi dïng gâ phÝm Enter ((). 

- Lïi ®Çu dßng: khi xuèng dßng v¨n b¶nth«ng th­êng ng­êi dïng cÇn lïi tõ vÞ trÝ ®Çu tiªn cña dßng vµo, ta thùc hiÖn b»ng c¸ch gâ phÝm Tab. 

--------------------------------------------
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Bµi 3: Thao t¸c víi tÖp v¨n b¶n
1.  Më File v¨n b¶n b¶nmíi:

(1) Thùc hiÖn lÖnh File ( New (hoÆc bÊm biÓu t­îng 
[image: image2.png]


) word më ra hép tho¹i:

(2) Chän Tab General vµ chän mÉu Blank Document. 
(3) KÕt thóc bÊm OK. 
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2.  Ghi tÖp v¨n b¶n(File) vµo æ ®Üa:

Khi cÇn l­u tr÷ néi dung v¨n b¶n ®ang so¹n th¶o vµo ta thùc hiÖn c¸c 

thao t¸c sau: 

(1) Thùc hiÖn lÖnh File ( Save 

(hoÆc kÝch vµo biÓu t­îng 
[image: image3.png]


). 

(2) Khi xuÊt hiÖn hép tho¹i Save 

ta lùa chän c¸c th«ng sè phï hîp theo

 chØ dÉn sau: 

§¸nh tªn v¨n b¶n vµo môc File name. 
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  (3) Ghi l¹i chän bÊm nót Save

· L­u v¨n b¶n b¶nvíi tªn kh¸c:

+ Vµo File chän Save as. 

+ §¸nh tªn v¨n b¶n b¶nkh¸c vµo môc file name. 

+ chän save. 
3.  Më v¨n b¶n ®· cã trªn ®Üa hoÆc trong th­ môc:

[image: image65.wmf]§Ó më v¨n b¶n ®· cã trªn ®Üa ®Ó söa ch÷a, chØnh lý vµ in. . . ta thùc hiÖn c¸c thao t¸c sau:

(1) Thùc hiÖn lÖnh File ( Open (HoÆc bÊm biÓu t­îng 
[image: image4.png]


)
(2) Khi xuÊt hiÖn hép tho¹i 

Open ta lùa chän file v¨n b¶n b¶nphï hîp. 

(3) ChÊp nhËn më v¨n b¶n b¶nbÊm nót Open. 
(
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7 kú quan thÕ giíi míi

Ch©u ¸ vµ Nam Mü mçi khu vùc cã 3 kú quan trong khi Ch©u ©u cæ kÝnh chØ cã 1 kú quan cho dï cã nhiÒu c«ng tr×nh ®​îc ®Ò cö nhÊt. KÕt qu¶ b×nh chän nµy võa ®​îc c«ng bè vµo ®óng  thø 7 ngµy 7 th¸ng 7 n¨m 2007 t¹i SVD Luz, Thñ §« Lisbon ë Bå §µo Nha.

3 kú quan thÕ giíi t¹i ch©u ¸ lµ: V¹n Lý Tr​êng Thµnh (Trung Quèc), §Òn Taj Mahal  (Ên §é), vµ §Òn Petra(Jordan).

Ba kú quan kh¸c ë Mü La Tinh lµ Thµnh phè Machu Picchu( Peru), T​îng chóa cøu thÕ t¹i Rio de Janeiro ( Brazil) vµ Chichen Itza (Mexico).

Yªu cÇu: 

· Më mét v¨n b¶n míi sö dông c¸c phÝm Tab, Enter, Shift vµ Caps Lock so¹n th¶o v¨n b¶n ®óng víi néi dung nh​ trªn.

· L​u l¹i v¨n b¶n víi tªn lµ “baitap1” sau ®ã tho¸t khái ch​¬ng tr×nh so¹n th¶o.

· Khëi ®éng ch​¬ng tr×nh so¹n th¶o më l¹i v¨n b¶n “baitap1” vµ gâ thªm néi dung d​íi ®©y vµo “baitap1”

“ChiÕn dÞch t×m kiÕm 7 kú quan thÕ giíi míi b¾t ®Çu tõ n¨m 1999 bëi nhµ kh¸m ph¸ Thuþ Sü Bernard Weber. H¬n 200 øng viªn ®​îc ®​a vµo danh s¸ch, nh​ng chèt l¹i chØ cã 21 c«ng tr×nh ®​îc ®Ò cö ®· c«ng bè.”
- L​u l¹i víi tªn lµ “ki quan the gioi”

Bµi 4: c¸c thao t¸c víi khèi v¨n b¶n:

1.  Chän khèi v¨n b¶n: 
Trong qu¸ tr×nh so¹n th¶o v¨n b¶ncã rÊt nhiÒu thao t¸c liªn quan ®Õn khèi v¨n b¶n, ®Ó chän khèi v¨n b¶n cÇn thao t¸c, ta cã thÓ sö dông bµn phÝm hoÆc dïng chuét. 


C¸ch 1: sö dông bµn phÝm:


(1) §­a con trá so¹n th¶o vÒ ®Çu hoÆc cuèi khèi v¨n b¶n cÇn chän. 


(2) Gi÷ phÝm Shift


(3) Gâ c¸c phÝm di chuyÓn con trá (((( ®Ó chän ®o¹n v¨n b¶n. 


C¸ch 2: Sö dông chuét:


- Chän mét khèi v¨n b¶n b¶nb»ng c¸ch di chuyÓn con chuét vÒ ®Çu khèi v¨n b¶n, bÊm nót tr¸i, gi÷ yªn vµ kÐo rª vÒ cuèi khèi. 


- Chän 1 tõ: bÊm ®óp chuét vµo tõ cÇn chän. 


- Chän 1 c©u: gi÷ phÝm Ctrl vµ bÊm chuét t¹i vÞ trÝ bÊt kú trong c©u. 


2.  Sao chÐp khèi v¨n b¶n:

Sao chÐp khèi v¨n b¶n ta thùc hiÖn c¸c b­íc thao t¸c sau:

(1) Chän khèi v¨n b¶n cÇn sao chÐp.  (B«i ®en khèi v¨n b¶n)

(2) Thùc hiÖn lÖnh Edit ( Copy (hoÆc bÊm biÓu t­îng 
[image: image5.png]


)

(3) Di chuyÓn con trá so¹n th¶o vÒ vÞ trÝ cÇn sao chÐp khèi v¨n b¶n (kÝch chuét tr¸i). 

(4) Thùc hiÖn lÖnh Edit ( Paste (hoÆc bÊm biÓu t­îng 
[image: image6.png]


). 


3.  Di chuyÓn khèi v¨n b¶n: (c¾t khèi v¨n b¶n)

§Ó di chuyÓn khèi v¨n b¶n ta thùc hiÖn theo c¸c b­íc thao t¸c sau:

(1) Chän khèi v¨n b¶n cÇn di chuyÓn.  (B«i ®en khèi v¨n b¶n)

(2) Thùc hiÖn lÖnh Edit ( Cut (hoÆc bÊm biÓu t­îng 
[image: image7.png]


,)

(3) Di chuyÓn con trá so¹n th¶o vÒ vÞ trÝ cÇn chuyÓn khèi v¨n b¶n. 

(4) Thùc hiÖn lÖnh Edit ( Paste (hoÆc bÊm biÓu t­îng 
[image: image8.png]


). 


4.  Xo¸ khèi v¨n b¶n:

Xo¸ khèi v¨n b¶n thùc hiÖn c¸c thao t¸c sau:

(1) Chän khèi v¨n b¶n cÇn xo¸.  (B«i ®en khèi v¨n b¶n)

(2) Thùc hiÖn lÖnh Edit ( Cut (hoÆc bÊm biÓu t­îng
[image: image9.png]


). 

Ngoµi ra cã thÓ xo¸ khèi v¨n b¶n b¶nb»ng phÝm Delete. 

Bµi 5: Tr×nh bµy v¨n b¶n
I.  Thay ®æi ph«ng (font) ch÷:


Víi c¸c ký tù trong v¨n b¶n cã nhiÒu h×nh thøc tr×nh bµy kh¸c nhau, th«ng th­êng ng­êi dïng quan t©m ®Õn mét vµi th«ng sè c¬ b¶n sau: Ph«ng ch÷ (Font); KiÓu ch÷ (Style) vµ kÝch th­íc con ch÷ (Size).  quy tr×nh ®Þnh d¹ng c¸c ký tù ®­îc thùc hiÖn theo c¸c thao t¸c sau:


(1) Chän ®o¹n ký tù cÇn ®Þnh d¹ng.      


(2) Thùc hiÖn lÖnh Fomat ( Font khi xuÊt hiÖn hép tho¹i Font chóng ta lùa chän c¸c th«ng sè c¬ b¶n (theo chØ dÉn h×nh 10). 
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(3) KÕt thóc bÊm nót OK. 


* Ph«ng ch÷: khi ta chän ph«ng ch÷ nµo th× h×nh d¸ng kiÓu ch÷ ®ã sÏ xuÊt hiÖn trong môc Preview (c¸c ph«ng ch÷ ViÖt Nam th­êng b¾t ®Çu lµ VN hoÆc Vn, c¸c ph«ng ch÷ in hoa th­êng kÕt thóc lµ ch÷ H hoÆc ch÷ U). 


* Víi kiÓu d¸ng ch÷ ta cã thÓ lùa chän mét trong c¸c kiÓu sau:



- Regular

Ch÷ b×nh th­êng



- Italic

Ch÷ nghiªng



- Bolditalic

Ch÷ ®Ëm nghiªng



- Bold

Ch÷ ®Ëm


* Trong môc Effects ta cã thÓ thÓ hiÖn mét sè hiÖu øng ®Æc biÖt, lùa chän vµ kiÓm nghiÖm cã thÓ quan s¸t qua môc Preview. 

* Trong môc kÝch th­íc (Size) ®­îc tÝnh b»ng sè ®iÓm (Point) mµ con ch÷ tr×nh bµy (víi c¸c v¨n b¶n b×nh th­êng kÝch th­íc con ch÷ vµo kho¶ng 12 - 14). 

L­u ý: - Khi so¹n th¶o v¨n b¶n th«ng th­êng thùc hiÖn theo hai giai ®o¹n, giai ®o¹n 1 so¹n th¶o th« (ch­a tr×nh bµy chi tiÕt), giai ®o¹n 2 tr×nh bµy toµn diÖn v¨n b¶n. 
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- Víi nh÷ng v¨n b¶n cã ®Þnh d¹ng phæ biÕn th­êng sö dông c¸c c«ng cô trªn thanh c«ng cô Fomat

 
Bài thực hành số 02

       Đây thôn Vĩ Dạ 

                      Hàn Mặc Tử 
Sao anh không về chơi thôn Vĩ? 

Nhìn nắng hàng cau nắng mới lên 

Vườn ai mướt quá xanh như ngọc 

Lá trúc che ngang mặt chữ điền.   

Gió theo lối gió mây đường mây 

Dòng nước buồn thiu hoa bắp lay. 

Thuyền ai đậu bến sông trăng đó. 

Có trở trăng về kịp tối nay.   

Mơ khách đường xa, khách đường xa, 

áo em trắng quá nhìn không ra 

Ở đây sương khói mờ nhân ảnh 

Ai biết tình ai có đậm đà?     

Yêu cầu 1:  Ghi lại văn bản này (với tên Baitho.doc).   

Định dạng bài thơ như trên.         

Gợi ý:   Tiêu đề của bài thơ viết bằng font chữ 'Times New Roman'; chữ đậm; cỡ chữ 14pt; Căn giữa. Tên tác giả căn phải; font chữ 'Times New Roman'; chữ đậm - nghiêng; cỡ chữ 10pt.   

Khổ thứ nhất: font chữ 'Tahoma'; chữ đậm; cỡ chữ 10pt; Căn Trái.   

Khổ thứ hai: font chữ 'Arial'; chữ nghiêng; cỡ chữ 10pt; Căn Trái; thụt đầu dòng (Increase Indent).   

Khổ thứ ba: font chữ 'Times New Roman'; hai câu trên chữ thường, hai câu thơ sau chữ nghiêng - đậm; màu xanh blue; cỡ chữ 10pt; Căn Trái.

Yêu cầu 2: Sử dụng các lệnh copy, cut, paste để được văn bản như sau:

Mơ khách đường xa, khách đường xa, 

áo em trắng quá nhìn không ra 

Ở đây sương khói mờ nhân ảnh 

Ai biết tình ai có đậm đà?     

Sao anh không về chơi thôn Vĩ? 

Nhìn nắng hàng cau nắng mới lên 

Vườn ai mướt quá xanh như ngọc 

Lá trúc che ngang mặt chữ điền.   

Bµi 6: T×m KiÕm thay thÕ 

vµ ®Æt chÕ ®é tù ®éng
1.  T×m kiÕm:

Khi muèn t×m kiÕm 1 tõ  hay 1 côm tõ nµo ®ã trong v¨n b¶n ta lµm nh­ sau:

· Vµo Edit chän Find hoÆc gâ Ctrl_F xuÊt hiÖn hép tho¹i:

· Gâ tõ cÇn t×m vµo môc Find what. 

· BÊm chuét vµo nót Find next ®Ó t×m kiÕm. 

· Muèn t×m côm tõ tiÕp l¹i bÊm vµo Find next. 

· Tho¸t bÊm Cancel hoÆc kÝch vµo X. 

2.  Thay thÕ tõ hay côm tõ. 


Khi kiÓm tra l¹i tµi liÖu hay v¨n b¶n ph¸t hiÖn 1 sè tõ gâ ch­a ®óng chÝnh t¶ hoÆc muèn thay ®æi 1 côm tõ thµnh 1 côm tõ kh¸c mµ nã lÆp ®i lÆp l¹i. ®Ó lµm ®iÒu ®ã ta sö dông chøc n¨ng t×m kiÕm  vµ thay thÕ Word tù ®éng. 

· Vµo Edit chän Replace hoÆc gâ Ctrl_H. 

· XuÊt hiÖn hép tho¹i:

· Gâ côm tõ cÇn thay (tõ lçi) vµo Find what.  VÝ dô: ViÖt nam. 

· Gâ côm tõ thay thÕ ( tõ míi) vµo môc Replace with.  VÝ dô: ViÖt Nam. 

· BÊm vµo Replace nÕu thay thÕ tõng tõ 1. 
· BÊm vµo Replace all nÕu thay thÕ tÊt c¶. 
· KÕt thóc bÊm Cancel. 
· Muèn nh¶y ®Õn trang cÇn t×m thùc hiÖn:

· Edit chän Goto hoÆc gâ Ctrl_G hoÆc gâ F5.  XuÊt hiÖn hép tho¹i:

Gâ trang cÇn ®Õn. 
· BÊm Goto. 
3.  ChÕ ®é tù ®éng. 

a.  T¹o tõ t¾t b»ng tèc kÝ:

· Vµo Tools chän AutoCorrect.  

· XuÊt hiÖn hép tho¹i:

+ ë Replace: gâ kÝ tù ®¹i diÖn. 

+ ë With: gâ dßng cÇn thay thÕ. 

+ Sau ®ã kÝch chuét vµo Add. 

+ KÕt thóc bÊm OK. 

b.  C¸ch sö dông tèc kÝ. 
· Gâ tõ t¾t råi gâ dÊu c¸ch. 

Bµi thùc hµnh 03

Gi¸m ®èc trung t©m
C¨n cø quyÕt ®Þnh sè 100/Q§-TW cña héi Nghiªn Cøu Khoa Häc §«ng Nam ¸ ViÖt Nam ban hµnh ngµy 28/09/2001 vÒ viÖc thµnh lËp Trung T©m §µo t¹o vµ Ph¸t TriÓn C«ng nghÖ PhÇn mÒm.

C¨n cø ®iÒu lÖ ho¹t ®éng cña Trung T©m §µo t¹o vµ ph¸t triÓn C«ng nghÖ PhÇn mÒm.

C¨n cø vµo nhu cÇu ph¸tt triÓn vµ ®µo t¹o cña Trung t©m §µo t¹o vµ ph¸t triÓn C«ng NghÖ PhÇn mÒm.

C¨n cø vµo viÖc tæ chøc nh©n sù cña Trung t©m.

QuyÕt §Þnh

§iÒu 1: Bæ nhiÖm «ng Vò Trung Kiªn lµm tr­ëng c¬ së Trung t©m ®µo t¹o Tin häc - Ngo¹i ng÷  - H¹ Long, sè 450 - §­¬ng Vò V¨n HiÕu - Hµ Tu - H¹ Long - Qu¶ng Ninh.

§iÒu 2: ¤ng Vò Trung Kiªn cã nhiÖm vô tuyÓn dông c¸n bé, tæ chøc, qu¶n lý mäi ho¹t ®éng cña Trung T©m §µo t¹o Tin häc - Ngo¹i ng÷   - H¹ Long.

§iÒu 3: ¤ng Vò Trung Kiªn chÞu tr¸ch nhiÖm vÒ mäi c«ng t¸c tæ chøc, ®µo t¹o cña Trung t©m ®µo t¹o Tin häc - Ngo¹i ng÷   - H¹ Long tr­íc ban Gi¸m ®èc Trung t©m §µo t¹o vµ ph¸t triÓn C«ng NghÖ   vµ tr­íc Ph¸p luËt Nhµ n­íc; chÞu sù qu¶n lý hµnh chÝnh cña chÝnh quyÒn ®Þa ph­¬ng.

§iÒu 4: C¸c «ng tr­ëng phßng vµ c¸n bé phËn liªn quan chiÕu theo quyÕt ®Þnh thi hµnh.

QuyÕt ®Þnh nµy cã hiÖu lùc kÓ tõ ngµy ký.

Yªu cÇu:

1. Sö dông chøc n¨ng t×m kiÕm xem cã tÊt c¶ bao nhiªu tõ  “phÇn mÒm”  sau ®ã thay thÕ tõ “phÇn mÒm” b»ng “m¸y tÝnh”

2. Thay thÕ côm tõ “Trung t©m ®µo t¹o Tin häc - Ngo¹i ng÷   - H¹ Long” b»ng côm tõ “ Trung t©m ®µo t¹o Tin häc  v¨n phßng”
3.  L­u l¹i víi tªn baitap3.doc
4. Sö dông chøc n¨ng tèc kÝ gâ l¹i bµi thùc hµnh 
“Trung t©m ®µo t¹o Tin häc - Ngo¹i ng÷   - H¹ Long” = tin häc

“Trung t©m §µo t¹o vµ ph¸t triÓn C«ng NghÖ PhÇn mÒm” = trung t©m

L­u l¹i víi tªn baithuchanh3.doc
Bµi 7: ChÌn kÝ tù ®Æc biÖt C¸c thao t¸c víi h×nh ¶nh

i.  ChÌn c¸c ký tù ®Æc biÖt:


Trong qu¸ tr×nh so¹n th¶o cã nh÷ng lo¹i v¨n b¶n th­êng xuyªn sö dông c¸c ký tù ®Æc biÖt (c¸c c«ng thøc, c¸c ký hiÖu), ®Ó chÌn c¸c ký tù ®Æc biÖt vµo v¨n b¶n ta thùc hiÖn c¸c b­íc thao t¸c sau:

- §Æt con trá t¹i vÞ trÝ cÇn chÌn ký tù ®Æc biÖt. 

- Thùc hiÖn lÖnh Insert -> Symbol. . . 

- Khi b¶ng chän Symbol xuÊt hiÖn ta lùa chän b¶ng ký hiÖu trong môc Font. 

- BÊm ®óp chuét vµo ký hiÖu cÇn chÌn (hoÆc chän ký hiÖu, sau ®ã bÊm nót Insert).  BÊm nót Close trªn hép tho¹i hoÆc trªn thanh tiªu ®Ò ®ãng hép tho¹i Symble. 


C¸c b¶ng Font sö dông nhiÒu:

- Symbol: c¸c ký hiÖu to¸n häc, ký tù Hyl¹p ((, (, (, (, (, (, (, (, (, (. . . )

- Wingdings: C¸c ký tù trang trÝ ((, (, (, (, (, (, (, (, (, (. . . )

- Weddings: c¸c biÓu t­îng thiÕt kÕ trang web ((, (, (, (, (, (, (. . . )
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II.  C¸c thao t¸c ®èi víi h×nh ¶nh. 

a.  ChÌn h×nh ¶nh:

- §Æt con trá vµo vÞ trÝ cÇn chÌn. 

- Vµo Insert\ Picture\ Clip art
 xuÊt hiÖn hép tho¹i:

· Tõ ®ã chän tranh cÇn chÌn vµ nhÊp

 chuét vµo nót Insert.

b. §Þnh d¹ng tranh:

- Chän tranh.

· Vµo Format \ Picture xuÊt hiÖn 

hép tho¹i:

· Chän Colors and Lines: ®Æt nÒn vµ

 khung cho ¶nh.

· Fill color: ®Æt mµu nÒn (nÕu kh«ng muèn ®Æt mµu nÒn Ên No Fill)...

· C¸ch tr×nh bµy tranh:

+ Chän tranh.

+ Vµo Format\Borders and Shading...

+ Chän Wrapping stype. 

+ Chän kiÓu  thÝch hîp cho tranh.

Bµi 8: ChØ sè trªn d­íi vµ

               c«ng thøc to¸n häc

1. ChØ sè trªn d­íi:

a. ChØ sè trªn:

+ BËt hoÆc t¾t chÕ ®é gâ chØ sè trªn: Ctrl + Shift + (+)


VD:

- Muèn viÕt ph­¬ng tr×nh: 
AX2 + BX + C = 0


Ta tiÕn hµnh c¸c b­íc:


- Tr­íc hÕt ta viÕt 
AX2 + BX + C = 0


- B«i ®en sè 2 vµo Format \ Font chän nót Superscript.


- HoÆc sö dông bµn phÝm: tr­íc tiªn ®¸nh AX sau ®ã gâ Ctrl + Shift + (+) råi gâ sè 2. Tho¸t khái chÕ ®é chØ sè trªn Ên l¹i 3 tæ hîp phÝm trªn.

b. ChØ sè d­íi:

+ BËt hoÆc t¾t chÕ ®é gâ chØ sè d­íi: Ctrl +    


· Muèn viÕt ký hiÖu ho¸ häc: H2SO4. Ta tiÕn hµnh nh­ sau:

- Tr­íc hÕt ta viÕt H2S04.

- B«i ®en sè 2 vµ sè 4, vµo Format \ Font chän nót Subscript.

- HoÆc sö dông bµn phÝm: tr­íc tiªn ®¸nh H sau ®ã gâ Ctrl +          råi gâ sè 2. Tho¸t khái chÕ ®é chØ sè d­íi Ên l¹i 2 tæ hîp phÝm trªn. TiÕp tôc lÆp l¹i thao t¸c cò b»ng c¸ch gâ tæ hîp phÝm.

2. ChÌn c«ng thøc to¸n häc:
- Vµo Tools \ customize
xuÊt hiÖn hép tho¹i: 
· Chän thÎ Commands, T¹i khung Categories chän Insert bªn c¹nh lµ khung Commands chän Equation Editor
· Lóc nµy mµn h×nh hiÖn b¶ng c«ng thøc vµ hép gâ c«ng thøc:



[image: image12.wmf]

- Trªn b¶ng chän c«ng thøc ta cã thÓ gâ bÊt k× c«ng thøc nµo mµ chóng ta muèn sau ®ã bÊm ra vÞ trÝ bÊt k× trªn mµn h×nh ®Ó nhËp c«ng thøc vµo v¨n b¶n.

So¹n th¶o v¨n b¶n vµ l­u víi tªn BAItap4:
Céng hoµ x· héi chñ nghÜa viÖt nam

§éc lËp - Tù do - H¹nh phóc

--------------------

(  ( (  (  ( ( ( ( ( ( ( 

So¹n th¶o c¸c c«ng thøc to¸n häc sau: 

1. Ph­¬ng tr×nh bËc hai: ax2 + bx + c = 0 cã hai nghiÖm ph©n biÖt x1.2= 
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2. Cho hµm sè 
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So¹n th¶o c¸c c«ng thøc ho¸ häc sau 

2AL + 2NaOH +2H2O = 2NaALO2 +3H2

​Zn + 2 NaOH + Na2ZnO​2 +H2

Chen mét sè h×nh ¶nh sau:

[image: image15.wmf][image: image16.wmf] [image: image17.wmf]
Bµi 9: §Æt lÒ v¨n b¶n – ph©n trang – ph©n cét
1. §Æt lÒ trang v¨n b¶n:

Theo trËt tù th«ng th­êng, ng­êi so¹n th¶o v¨n b¶n th­êng chän kÝch th­íc giÊy tr­íc sau ®ã míi viÕt vµ tr×nh bµy v¨n b¶n, nh­ng víi c¸c hÖ so¹n th¶o cµi ®Æt trong m¸y tÝnh ®iÖn tö th­êng ®Æt mét khæ giÊy ngÇm ®Þnh th«ng dông v× vËy víi v¨n b¶n th«ng dông ng­êi dïng kh«ng cÇn tr×nh bµy l¹i lÒ, ®Æt l¹i khæ giÊy, trang in. 


(1) Thùc hiÖn lÖnh File -> Page Setup. . . 


(2) Khi xuÊt hiÖn hép tho¹i Page Setup ta thùc hiÖn chän c¸c th«ng sè theo chØ dÉn KÕt thóc bÊm nót OK. 

2. §Æt lÒ cho ®o¹n v¨n b¶n:
- §Ó ®Þnh d¹ng cho 1 ®o¹n v¨n b¶n chóng ta cÇn thùc hiÖn c¸c thao t¸c sau:


(1) B«i ®en ®o¹n v¨n b¶n cÇn ®Þnh d¹ng. 


(2)Thùc hiÖn lÖnh Format ( Paragraph. . .  khi xuÊt hiÖn hép tho¹i Paragraph ta lùa chän c¸c th«ng sè kÌm theo chØ dÉn trong h×nh 
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(3) KÕt thóc bÊm chuét vµo nót OK. 

· Canh lÒ cho ®o¹n cã 4 lùa chän sau:

- Justified
: Canh th¼ng hai lÒ cña ®o¹n vb. 



- Right
: Canh th¼ng lÒ ph¶i ®o¹n vb. 





- Left

: Canh th¼ng lÒ tr¸i ®o¹n vb. 



- Center
: Canh gi÷a ®o¹n vb. 

· Víi kho¶ng c¸ch gi÷a c¸c dßng v¨n b¶n ta cã c¸c lùa chän sau:

- Single
: Kho¶ng c¸ch b×nh th­êng. 

- 1. 5 line
: Kho¶ng c¸ch b»ng 1,5 lÇn kho¶ng c¸ch b×nh th­êng. 

- Double
: Kho¶ng c¸ch b»ng 2  lÇn kho¶ng c¸ch b×nh th­êng. 

- At least
: Kho¶ng c¸ch gi÷a c¸c dßng xÝt l¹i. 

L­u ý
: víi c¸c ®o¹n v¨n b¶n cã ®Þnh d¹ng th«ng dông, ng­êi dïng th­êng sö dông c¸c c«ng cô trªn thanh c«ng cô Formatting. 
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----------------------------------------------

Bµi thùc hµnh sè 05
So¹n th¶o v¨n b¶n sau, ®Þnh d¹ng theo mÉu vµ l­u l¹i víi tªn baitap5

¸o tr¾ng
L©u qu¸ kh«ng vÒ th¨m xãm ®¹o

Tõ ngµy binh löa xo¸ quª h­¬ng

Khãi bom che lÊp ch©n trêi cò 

Tre c¶ tr­êng x­a nãc gi¸o ®­êng

M­êi n¨m cò em cßn ®i häc

¸o tr¾ng t« ®iÓm ®êi n÷ sinh

Hoa tr¾ng cµi duyªn lªn ¸o tÝm

Em lµ c« g¸i tuæi b¨ng trinh

Tr­êng anh ngã mÆt gi¸o ®­êng

G¸c chu«ng th­¬ng nhí lÇu chu«ng

Buån b· thay chu«ng nh¹c ®¹o

Rén r· thay chu«ng nhµ tr­êng

LÇn n÷a anh ghiÒn nghe tiÕng chu«ng

Lµm th¬ sÇu muén dÖt t×nh th­¬ng

§Ó nghe khe khÏ lêi em nguyÖn

Th¬ thÈn chê em tr­íc th¸nh ®­êng

Mçi lÇn tan lÔ chu«ng ngõng ®ç

Hai bãng cïng ®i mét lèi vÒ

E lÖ em cÇu kinh nho nhá

Ng¹i ngïng anh ®øng l¹i kh«ng ®i

Sau m­êi n¨m lÎ anh th«i häc

Nøc në chu«ng ®­êng buæi biÖt ly

Rén r· tõng håi chu«ng xãm ®¹o

TiÔn nµng ¸o tr¾ng b­íc vu quy

Yªu cÇu: ®Þnh d¹ng trang v¨n b¶n khæ A4, lÒ trªn =2cm, lÒ d­íi =2cm, lÒ tr¸i =3cm, lÒ ph¶i =1.5cm
- kho¶ng c¸ch gi÷a c¸c dßng lµ 1.3, kho¶ng c¸ch gi÷a c¸c khæ th¬ lµ 12pt, kho¶ng c¸ch gi÷a c¸c khæ th¬ so víi lÒ tr¸i.
Bµi 10: §¸nh sè thø tù tù ®éng

   §¸nh dÊu ®Çu ®o¹n

1. §¸nh sè thø tù tù ®éng:

· §¸nh dÊu c¸c ®o¹n v¨n b¶n cÇn ®¸nh sè:

· Vµo Format \ Bulletes and Numbering xuÊt hiÖn hép tho¹i:

· Chän Numbered.
· Chän 1 trong c¸c h×nh bªn.

·  KÕt thóc Ên OK
2. §¸nh dÊu ®Çu ®o¹n:

· Vµo Format \ Bulletes and Numbering xuÊt hiÖn hép tho¹i:

· Chän Bulleted: Chän c¸c kiÓu dÊu ®Çu ®o¹n mong muèn.



Bµi 11: T¹o ch÷ nghÖ thuËt

1. ChÌn ch÷ nghÖ thuËt:

· §Æt con trá t¹i vÞ trÝ cÇn chÌn.

· Vµo Insert\ Picture\ Word Art xuÊt hiÖn hép tho¹i kÝch chän d¹ng ch÷ nghÖ thuËt tuú ý.
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· KÕt thóc Ên OK.

· XuÊt hiÖn hép tho¹i ®¸nh ch÷ cÇn t¹o -> OK
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+ Font: chän Font ch÷.

+ Text: So¹n th¶o v¨n b¶n nghÖ thuËt.

+ Size: §Æt l¹i cì ch÷.

· Ngoµi ra cã thÓ ®Þnh d¹ng b»ng thanh c«ng cô.

2. §Þnh d¹ng ch÷ nghÖ thuËt.

· Thay ®æi ®é réng cña ch÷ nghÖ thuËt.

· Di chuyÓn ch÷ nghÖ thuËt.

· §æi l¹i néi dung ch÷ nghÖ thuËt.

-  Thay ®æi kiÓu d¸ng ch÷ nghÖ thuËt.

Bµi thùc hµnh sè 06
Bµi 1: §¸nh sè thø tù ®Çu ®o¹n
Danh s¸ch 7 kú quan thÕ giíi míi
1. V¹n lý tr­êng thµnh (Trung Quèc)

2. §Òn Taj  Mahal (Ên ®é)

3. §Òn Petra (Jordan)

4. §Êu tr­êng Colosseum Roma (Italia)

5. Thµnh phè machu picchu (Peru)

6. T­îng chóa cøu thÕ Janerio (Brazil)

7. Chichen Itaza (Mexico)
Bµi 2: So¹n th¶o bµi th¬: T«i ®i t×m mïa thu
T«i ®i t×m mïa thu

N¾ng vµng n¬i gãc phè 

Con thuyÒn t×m bÕn ®ç 

X«n xao biÓn ®îi chê

T«i ®i t×m mïa thu 

L¸ vµng r¬i trong giã 

V­ên nhµ ai hoa cá 

Theo b­íc ch©n em vÒ

T«i ®i t×m mïa thu

C« ®¬n cïng nçi nhí

Thu vÒ trong h¬i thë

Em cã cßn qua ®©y

Mét chót giã heo may

Mïa thu sµng thËt l¹

Mµ ng­êi nay xa qu¸ 

§Ó lßng ta buån th­¬ng

Mï thu còng vÊn v­¬ng

Mèi t×nh ta ngµy ®ã

L¸ vÉn r¬i trong giã 

          N¾ng vÉn vµng trªn cao
Bµi 12: T¹o b¶ng biÓu trong v¨n b¶n

1. ChÌn b¶ng

- §Ó t¹o lËp b¶ng biÓu trong Word cã nhiÒu c¸ch thùc hiÖn kh¸c nhau song ng­êi dïng th­êng sö dông 2 c¸ch th«ng th­êng sau:


ChÌn b¶ng (Insert Table)

 C¸c b­íc thao t¸c thùc hiÖn nh­ sau:


(1) Di chuyÓn con trá so¹n th¶o vÒ vÞ trÝ cÇn chÌn b¶ng. 


(2) Thùc hiÖn lÖnh Table (insert ( Table. 


(3) Khi xuÊt hiÖn hép tho¹i ta lùa chän c¸c th«ng sè theo chØ dÉn H16. 
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VÏ B¶ng (Draw Table)

C¸c b­íc thùc hiÖn nh­ sau:



(1) LÊy c«ng cô vÏ: thùc hiÖn lÖnh Table -> Draw Table hoÆc chän c«ng cô 
[image: image23.png]


 trªn thanh c«ng cô. 



(2) sö dông c¸c c«ng cô trªn thanh c«ng cô Table ®Ó vÏ b¶ng:



1. Di chuyÓn

· Sö dông phÝm tab ®Ó di chuyÓn qua tõng « trong b¶ng.

+ §Õn « kÕ tiÕp: tab.

+ §Õn « tr­íc ®ã: Shift + tab.

+ §Õn « ®Çu tiªn (cuèi cïng) cña dßng hiÖn t¹i: Alt + Home(End).

+ §Õn « ®Çu tiªn (cuèi cïng ) cña cét: Alt + Page up(Page down).

3. Thay ®æi kÝch th­íc c¸c hµng hoÆc cét.

· §­a con trá so¹n th¶o vµo b¶ng.

· Thùc hiÖn lÖnh Table\ table properties\chän theo th«ng sè thÝch hîp .

4. §Æt nÒn vµ kÎ viÒn cho ®o¹n v¨n b¶n.

· Chän ®o¹n v¨n b¶n cÇn ®Æt nÒn hay kÎ khung.

· Vµo Format\borders and shading…
·  chän th«ng sè thÝch hîp.

· KÕt thóc Ên OK.

5. C¸c thao t¸c chÌn xo¸ trong b¶ng. 
* Thªm c¸c «, cét, hµng:

· §­a con trá vÒ vÞ

 trÝ trong b¶ng.

- Vµo Table\insert:

* Xo¸ c¸c «, cét, hµng:

- Thùc hiÖn lÖnh: Table -> Delete...
 Chän ph¹m vi «, cét, dßng cÇn xo¸.

- BÊm OK
6. Gép c¸c «, cét, hµng (t¸ch).

a. Gép «, cét, hµng:

· Chän cét cÇn gép(cã thÓ gåm

 nhiÒu « hoÆc hµng).

· Vµo Table\ Merge cells.

b. T¸ch 1 cét thµnh nhiÒu cét nhá.

· Chän cét cÇn t¸ch.

· Vµo Table\ split cell xuÊt hiÖn hép tho¹i:

+ Number of columns: NhËp sè cét cÇn t¸ch.

+  Number of Rows: NhËp sè hµng cÇn t¸ch.

So¹n th¶o v¨n b¶n vµ l­u víi tªn BAI7
Céng Hoµ X· Héi Chñ NghÜa ViÖt Nam

§éc lËp - Tù do - H¹nh phóc

---------o0o----------

Biªn B¶n §èi ChiÕu 
Thùc HiÖn Hîp §ång
(tõ ngµy 20/4/2009 ®Õn ngµy 30/4/2011)


- C¨n cø vµo H§KT Sè 345 ngµy 20 th¸ng 10 n¨m 2001 ®· kÝ gi÷a hai bªn.


- C¨n cø vµo chøng tõ giao nhËn vµ thanh to¸n gi÷a hai bªn.

H«m nay, ngµy 20 th¸ng 4 n¨m 2009.

§¹i diÖn bªn A:

	1. ¤ng NguyÔn V¨n Phong
	Chøc vô: Gi¸m ®èc

	2. ¤ng Vò Hoµng Qu©n 
	Chøc vô: Phã Phßng


§¹i diÖn bªn B:

	1. ¤ng NguyÔn §øc Phó
	Chøc vô: Tr­ëng Phßng 

	2. ¤ng TrÇn Minh Thµnh
	Chøc vô: Phã gi¸m ®èc


Hai bªn cïng nhau ®èi chiÕu sè liÖu thùc hiÖn H§KT theo néi dung sau: 

I. KÕt qu¶ thùc hiÖn hîp ®ång:

1. Khèi l­îng vµ gi¸ trÞ hµng bªn A mua cña bªn B trong kú ®èi chiÕu: 

	STT
	Ngµy th¸ng
	Tªn Hµng
	Khèi l­îng
	§¬n gi¸
	Thµnh tiÒn

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	Tæng céng
	
	
	


(Sè tiÒn b»ng ch÷ : …………………………………………)

2. Thanh to¸n:


- Sè ®Çu kú bªn A cßn nî bªn B ®Õn ngµy 30/4/2011. Sè tiÒn:


- Sè ph¸t sinh trong kú (bªn A mua cña bªn B). Sè tiÒn:


- Sè thanh to¸n trong kú (bªn A tr¶ bªn B). Sè tiÒn:


- Sè d­ cuèi kú bªn A cßn nî bªn B ®Õn ngµy 30/4/2011. Sè tiÒn:

II. Tr¸ch nhiÖm cña mçi bªn:

1. Tr¸ch nhiÖm bªn A: ChuyÓn tr¶ cho bªn B theo hîp ®ång.

2. Tr¸ch nhiÖm bªn B: Cung cÊp hµng cho bªn A theo tiÕn ®é vµ yªu cÇu cña hîp ®ång.

  Biªn b¶n nµy thèng nhÊt lËp thµnh 02 b¶n mçi bªn gi÷ 01 b¶n cã gi¸ trÞ ph¸p lý nh­ nhau lµm c¨n cø quyÕt to¸n trong qu¸ tr×nh thùc hiÖn hîp ®ång.

	§¹i diÖn bªn A
	§¹i diÖn bªn B


Bµi 13: Chia cét cho ®o¹n v¨n b¶n – T¹o ch÷ hoa ®Çu ®o¹n

1. Ph©n cét cho ®o¹n v¨n b¶n.

· Vµo Format\ columns xuÊt hiÖn hép tho¹i: 

+ Trong « Presets: 


One: Trë l¹i 1 cét.


Two: Trë l¹i 2 cét.


Three: Trë l¹i 3 cét.


Left and right: 2 cét nh­ng lÖch nhau.

+ Number of columns: gâ vµo sè cét cÇn thiÕt.

+ Preview: MÉu tr×nh bµy cña trang in.

2. T¹o ch÷ hoa ®Çu ®o¹n:

§Ó tr×nh bµy mét ch÷ to cho ®Çu ®o¹n v¨n b¶n, ta thùc hiÖn c¸c thao t¸c sau:

(1)§­a con trá so¹n th¶o vÒ ®o¹n cÇn ®Æt ch÷ to. 

(2)Thù hiÖn lÖnh:Format->Drop Cap.

(3) Thùc hiÖn theo chØ dÉn h×nh bªn vµ chän OK. 

· §Ó huû bá hiÖu øng trong Position
 chän None.


Bµi thùc hµnh 08

So¹n th¶o v¨n b¶n theo mÉu sau:


A
nh ®­a em ®i thuë ®Çu häc Dos
Ngãn tay em mÒm run rÈy gâ lÖnh dir.

Nh­ thÕ ®ã hån anh ®ang bµy tá
Em ®i t×m xem DELETE ®­îc File nµo

A

nh giê ®©y «m c¶ v¹n tr¨ng sao

Tim më cöa, em Type ra sÏ râ

Hån vÑn nguyªn ®©u Format lÇn nµo.

ChØ Defrag nÕu sao trêi lén xén

M

çi v× soa Èn nçi nhí cån cµo.

Anh gom hÕt ®­a vµo tõng th­ môc.

Nµy th­ môc nhí råi th­ môc th­¬ng.

Anh hái lßng chiÕm bao nhiªu HardDisk
E

m yªu ¬i råi ®Õn ngµy xong DOS.

Anh tÇn ngÇn: “bÐ cã häc Windows”

TuyÖt ph¶i biÕt bao nh÷ng t­¬ng giao ®«g ho¹

Em xiªu lßng “em sÏ häc theo anh”

T
hËt bµng hoµng khi chung tay cÇm chuét

D¹ xèn xang trèng ngùc ®æ rén rµng

Trong program cã in h×nh cöa sæ

Cöa nhµ em, anh ®øng ®îi bao lÇn

(((((((
(
(((((((
(


§

ång hå c¸t trong lßng anh ®¶o lén
Corel buån ch¼ng vÏ næi t×nh anh

Ngµy qua nhanh lêi yªu råi còng ngá.

Em l¾c ®Çu ...vôn vë tr¸i tim ®au...

V

µ giê ®©y bµi th¬ t×nh viÕt véi.

Thay nô c­êi g­îng g¹o buæi chia tay.

A

nh t×m quªn mèi t×nh cßn lì dë
M¸y halt råi Reset n÷a mµ chi

L¹i ch¼ng quªn, ®ªm tõng ®ªm méng mÞ

Gäi tªn em Password cña lßng anh

VÏ h×nh trong Word

* C¸ch lÊy thanh c«ng cô vÏ h×nh:

· C1: Nh¸y chuét ph¶i lªn thanh c«ng cô vµ chän Drawing

· C2: KÝch biÓu t­îng 
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 xuÊt hiÖn thanh c«ng cô:
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1. VÏ h×nh Elip:

+ KÝch chuét vµo biÓu t­îng Oval

+ §­a con trá chuét vµo vïng v¨n b¶n cÇn vÏ, gi÷ chuét tr¸i kÐo rª sang bªn ®Ó ®­îc h×nh elip cÇn vÏ.

+ Nh¶ chuét tr¸i.

Chó ý: §Ó vÏ h×nh trßn, sau khi kÝch chän nót vÏ nhÊn phÝm shift trong khi rª chuét vÏ h×nh elip.

2. VÏ h×nh ch÷ nhËt.

+ KÝch chuét vµo biÓu t­îng h×nh ch÷ nhËt: 

+ §­a con trá chuét vµo vïng v¨n b¶n cÇn vÏ, gi÷ chuét tr¸i kÐo rª sang bªn ®Ó ®­îc h×nh ch÷ nhËt cÇn vÏ.

+ Nh¶ chuét tr¸i.

Chó ý: §Ó vÏ h×nh vu«ng, sau khi kÝch chän nót vÏ nhÊn phÝm shift trong khi rª chuét vÏ h×nh ch÷ nhËt.

3. VÏ hép v¨n b¶n. [image: image26.png]



4. VÏ ®­êng th¼ng mòi tªn.

5. VÏ 1 sè h×nh ®Æc biÖt. [image: image27.png]#Autoshapes ~




· KÝch vµo nót c«ng cô Autoshapes. 

· KÝch chän theo c¸c tuú chän.

* §Ó ®¸nh ch÷ trong h×nh ta kÝch biÓu 

t­îng 
[image: image28.png]


 råi gi÷ chuét tr¸i kÐo rª th¶ 

vµo h×nh võa vÏ.

6 In v¨n b¶n
- nhÊn nót [image: image29.png]


 Trªn thanh c«ng cô.

- Vµo File -> Print 

- NhÊn tæ hîp phim CTRl + P 
 





Bµi Thùc hµnh 09: dïng thanh c«ng cô Drawing cña word t¹o s¬ ®å sau







Dïng thanh c«ng cô Drawing vµ kiÕn thøc ®· häc t¹o s¬ ®å sau:

	Sè TT
	§µo t¹o hÖ
	KÕ ho¹ch
	Thùc hiÖn

	
	
	TS
	N÷
	TS
	% so víi KH

	(
	( §¹i häc
	50
	27
	40
	80%

	(
	( Cao ®¼ng
	60
	30
	50
	100%


V.  mét sè ®Þng d¹ng kh¸c:

1. §Þnh d¹ng Tab:

Trong qu¸ tr×nh so¹n th¶o v¨n b¶n viÖc tr×nh bµy mét dßng v¨n b¶n ®­îc ph©n chia theo nhiÒu ®o¹n kh¸c nhau vµ tr×nh bµy néi dung v¨n b¶n theo c¸c cét môc lµ nhu cÇu th­êng gÆp. 

VD1: khi tr×nh bµy mét tiªu ®Ò v¨n b¶n, phÇn ®Çu tiªu ®Ò ®­îc chia thµnh hai phÇn vµ ®­îc canh gi÷a hai ®iÓm 3,5 cm vµ 12,5 cm. 
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VD2:
Khi tr×nh bµy v¨n b¶n theo cét, cét ®Çu canh lÒ tr¸i t¹i ®iÓm 3 cm, cét thø 2 canh lÒ ph¶i t¹i ®iÓm 12 cm. 
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§Ó ®Þnh d¹ng c¸c Tab cè ®Þnh cña ng­êi dïng khi gâ phÝm Tab ta thùc hiÖn nh­ sau:

(1) Thùc hiÖn lÖnh Format -> Tab. . . 

(2) Khi xuÊt hiÖn hép tho¹i ta thùc hiÖn lùa chän c¸c th«ng sè theo chØ dÉn:
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2. T¹o tiªu ®Ò ®Çu dßng vµ cuèi dßng

· chon menu View -> header and footer
®¸nh sè trang v¨n b¶n:
  [image: image33.png]Ingert AutoText -





VI.  ChÌn Ng¾t Trang:


So¹n th¶o v¨n b¶n trong Word th«ng th­êng Word tù ®éng xuèng dßng khi hÕt kÝch th­íc mét trang v¨n b¶n b¶n®· ®Þnh d¹ng.  Trong mét sã tr­êng hîp nh­ cã sù ng¾t trang gi÷a tiªu ®Ò vµ néi dung, cã sù chia c¾t b¶ng biÓu, ng­êi so¹n th¶o cã thÓ chñ ®éng ng¾t trang theo ý m×nh.  Muèn nh­ vËy ta lµm nh­ sau:


- §Æt con trá so¹n th¶o t¹i vÞ trÝ cÇn ng¾t trang (tøc chuyÓn sang trang míi). 


- Thùc hiÖn lÖnh: Insert -> Break (th­êng ®­îc ngÇm ®Þnh s½n), hoÆc cã thÓ gâ ngay tæ hîp phÝm: Ctrl + Enter. 

- ChÊp nhËn bÊm OK. 

* Khi cÇn bá ng¾t trang, ta thùc hiÖn thao t¸c xo¸ nh­ víi ký tù b×nh th­êng. 

C¸c phÝm nãng:

Thao t¸c


                       BÊm phÝm (dÊu – lµ ®¸nh ®ång thêi)

Thùc hiÖn lÖnh trong menu



ALT - ký tù g¹ch ch©n

§ãng cöa sæ ch­¬ng tr×nh hiÖn thêi


ALT - F4
Sao chÐp c¸i b«i ®en (Copy)



CTRL - C
C¾t c¸i b«i ®en (Cut)




CTRL - X

D¸n (Past)






CTRL - V
Më v¨n b¶n b¶nmíi




CTRL - N
Më v¨n b¶n b¶n®· cã trong 1 th­ môc


CTRL - O

Ghi v¨n b¶n b¶nvµ ®Æt tªn



CTRL - S
T¹o ch÷ ®Ëm (B)





CTRL - B

T¹o ch÷ nghiªng (I)




CTRL -i

T¹o ch÷ g¹ch ch©n ®Ëm (U)



CTRL - U
§¸nh chØ sè trªn ( m3)




CTRL - SHIFT - + 

§¸nh chØ sè d­íi ( H20 )




CTRL - +

B«i ®en toµn bé v¨n b¶n




CTRL – A
LÊy l¹i c¸i ®· mÊt 





CTRL – Z
C¨n lÒ tr¸i cña v¨n b¶n 
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CTRL – L
C¨n lÒ ph¶i cña v¨n b¶n
[image: image35.png]






CTRL – R
C¨n v¨n b¶n b¶nvµo gi÷a      
[image: image36.png]






CTRL – E
C¨n ®Òu hai bªn v¨n b¶n b¶n
[image: image37.png]






CTRL – J
Xo¸ ký tù sau (bªn ph¶i) con trá


DELETE
Xo¸ ký tù tr­íc(bªn tr¸i) con trá
 

BackSpace (    )

Trung t©m ®iÖn tö vµ tin häc
	[image: image38.wmf]
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§¬n Ghi Danh
( phÇn v¨n phßng ghi (ng­êi phô tr¸ch ghi):

· Líp:
T¹i (tØnh):


· Ngµy giê häc:
Khai gi¶ng:


(phÇn häc viªn ghi:
1) Hä vµ tªn (ch÷ in hoa):



2) Sinh ngµy:
T¹i tØnh:


3) §Þa chØ:



4) V¨n ho¸ (nÕu sinh viªn th× ghi n¨m häc):


5) §ang lµm g×, ë ®©u (nÕu sinh viªn th× ghi tr­êng):


6) BiÕt nghÒ nghiÖp chuyªn m«n g× (ngoµi v¨n ho¸):

7) Ngo¹i ng÷:
Søc khoÎ:


8) Häc phÝ ®ãng lÇn 1:



	
	H¹ long, ngµy …..th¸ng……n¨m 2010

(häc viªn ký tªn)


Bµi thùc hµnh 11: MAIL MERGER  (TRén v¨n b¶n)
Tr­íc khi häc c¸ch trén v¨n b¶n, b¹n lµm quen víi mét sè kh¸i niÖm sau:

- Mail Document: Mét tÖp (file) v¨n b¶n mÉu ®· ®­îc so¹n th¶o vµ ®Þnh nghi· hoµn chØnh

VÝ dô: Néi dung giÊy mêi nh­ng ch­a ®iÒn tªn ng­êi mêi

· Data soure: lµ file chøa nguån d÷ liÖu, file nµy th­êng ®­îc tr×nh bµy d­íi d¹ng b¶ng biÓu ®¬n gi¶n nh­ Table, hay sheet trong Excel.

· VÝ dô: B¶ng danh s¸ch kh¸ch mêi

· Field: Lµ cét trong b¶ng biÓu, nã chØ chøa th«ng tin cho mét yªu cÇu trong v¨n b¶n mÉu.

· VÝ dô Trong b¶ng danh s¸ch kh¸ch mêi cã cét hä vµ tªn l­u hä vµ tªn kh¸ch mêi
· Field Name: Tªn cña mçi cét, c¸c cét ph¶i cã tªn kh¸c nhau, tªn cét kh«ng cã kho¶ng tr¾ng vµ kh«ng nªn dïng ch÷ cã dÊu hay dÆt tªn cét qu¸ dµi.

· Record: B¶n ghi mµ mçi hµng trong b¶ng d÷ liÖu nguån, nã thÓ hiÖn toµn bé th«ng tin cña ®èi t­îng.
C¸c b­íc thùc hiÖn v¨n b¶n nh­  sau:

· B­íc 1: ChuÈn bÞ d÷ liÖu

+ T¹o mét v¨n b¶n hoµn chØnh.

VÝ dô: B¹n t¹o mét th«ng b¸o nh­  sau:

Bé gi¸o dôc vµ ®µo t¹o

Tr­êng §¹i Häc B¸ch Khoa Hµ Néi

===(===

GiÊy b¸o nhËp häc

Tr­êng §¹i Häc B¸ch Khoa Hµ Néi tr©n träng th«ng b¸o cho:

Sinh viªn:
Sinh ngµy:


§Þa chØ:



§óng 8 giê 00 phót, ngµy 07 th¸ng 04 n¨m 2011 cã mÆt t¹i v¨n phßng nhµ tr­êng ®Ó lµm thñ tôc nhËp häc.Khi ®i mang theo giÊy b¸o ®iÓm.

                                                                                   Hµ néi, ngµy     th¸ng      n¨m  2010

                                                                                                           HiÖu tr­ëng

B¹n l­u v¨n b¶n nµy víi tªn lµ Giaybao, sau ®ã t¹o mét file v¨n b¶n míi lµ file v¨n b¶n nguån cã chøa mét b¶ng biÓu nh­ sau:

	Ten
	Nam sinh
	Dia chi

	Ng« Xu©n Hång
	05/04/1984
	H¹ Long Qu¶ng Ninh

	NguyÔn Thuý H»ng
	01/09/1988
	U«ng BÝ Qu¶ng Ninh

	Ph¹m ViÖt Hïng
	04/01/1986
	§«ng TriÒu Qu¶ng Ninh

	NguyÔn §øc ViÖt
	25/03/1985
	Mãng C¸i Qu¶ng Ninh


L­u v¨n b¶n nµy víi tªn danhsach.
B­íc 2: TiÕn hµnh trén v¨n b¶n.

· Më file v¨n b¶n mÉu – Main document Giaybao.

· B¹n chän Tools\Letters and Mailings\Show Mail Merge Toolbar. B¹n sÏ thÊy thanh c«ng cô Mail Merge nh­ h×nh d­íi d©y.

[image: image39.png]




Trªn thanh Mail Merge nhÊn Main Document Setup khi ®ã xuÊt hiÖn hép tho¹i sau.

-Chän Normal Word document sau nhÊn Ok

-Chän Open Data Source trªn thanh c«ng cô më File nguån b¹n ®· t¹o cã tªn lµ danhsach.

- ChuyÓn con trá tíi vÞ trÝ cÇn chÌn tr­êng d÷ liÖu, Chän Insert Merge field trªn thanh c«ng cô.

-Sau ®ã chÌn ®óng tr­êng d÷ liÖu nguån vµo vÞ trÝ cÇn chÌn trong v¨n b¶n mÉu b¹n chuyÓn con trá so¹n th¶o tíi vÞ trÝ cÇn chÌn sau ®ã nhÊn chuét vµo nót Insert
-Khi ®· chÌn ®ñ tÊt c¶ c¸c tr­êng d÷ liÖu thÞ ta nhÊn chuét vµo nót lÖnh [image: image40.png]


 ®Ó tiÕn hµnh trén v¨n b¶n
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Nhãm lÖnh so¹n th¶o vb





Nhãm lÖnh vÒ b¶ng biÓu





















































Nhãm lÖnh trî gióp
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Nhãm lÖnh ®Þnh d¹ng
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